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Overview
TxEdit is an easy-to-use text editor that makes a nice replacement for the MS Windows Notepad. Multiple documents can be 
edited using this MDI editor. Search and replace options are included. Text files of up to 10 Megabytes each can be edited and 
printed.

TxEdit for Windows 95/NT is fully Y2K compliant and will work with MS Windows 98 as well as Windows 95/NT systems.

Drag & Drop
Drag and Drop documents to quickly open files for editing and viewing. To open files directly from the MS Windows Explorer or 
the desktop simply drag the file’s icon to the TxEdit window and the file or files you have selected will be opened.

Macintosh and UNIX Files
TxEdit can open and view Macintosh and UNIX formatted text files as well as normal Microsoft Windows and MS DOS ASCII 
text documents.

SysEdit Utility
TxEdit can also be used as a replacement for the original SYSEDIT.EXE program that shipped with MS Windows 3.x systems.

Custom Tools Menu
TxEdit can be configured to launch your favorite programs and development tools. TxEdit will optionally load your choice of tools
and include the contents of the currently active window as that tool’s command line argument.

Automatic Text Macros
TxEdit can be configured to automatically insert predefined text and phrases that you type often. One command key can be 
used to insert entire paragraphs of text that you define. Up to 2000 characters of text can be used for each TxEdit macro that 
you define.

Purchasing TxEdit
TxEdit for Windows 95/NT is a fully functioning program. It is not crippled in any way.

TxEdit    for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are 
required to register it. If after evaluating TxEdit for 30 days you decide not to register it you are required to remove it from your 
computer.

Registration entitles you to unlimited free updates and support via E-Mail or telephone.

You may also purchase TxEdit for Windows 95/NT using your credit card via the Internet or by telephone.

Desktop Locations
TxEdit’s location on the desktop is saved when the program is exited. Whenever you start TxEdit it will reappear on the desktop 
where you last placed it. TxEdit property sheet locations are also stored and reused the next time they are opened.

Taskbar Tray
TxEdit for Windows 95/NT can be optionally configured to place its program icon in the Taskbar Icon Notification Tray. This 
option provides a simple means of keeping the taskbar button region clear for other running programs.



Installing TxEdit
Installation
To install TxEdit for Windows 95/NT on your computer simply create a new, empty folder and place the files; TXEDIT.EXE, 
TXEDIT.HLP and TXEDIT.CNT there.

TXEDIT.EXE - The TxEdit Application
TXEDIT.HLP - The Windows 95/NT Help File
TXEDIT.CNT - The Help Contents File

If you installed TxEdit for Windows 95/NT using the SETUP.EXE program and selected the default installation setting TxEdit for 
Windows 95/NT will be installed in the C:\Program Files\Software by Design folder.

To integrate TxEdit for Windows 95/NT with the MS Windows Explorer select the Help | Setup menu item to open the TxEdit 
Explorer Setup property sheet.

Note to Previous Users
If you are upgrading from an earlier version of TxEdit for Windows 95/NT make certain the older version is not running before 
installing the new release. Install the new version in the same folder as the prior version. Your TxEdit Settings will be retained 
and used by the new release.

Note The TXEDIT.INI file is no longer used and can be deleted. The various application settings specified in the TxEdit Options 
property sheet as well as the main window’s size and location on the desktop are now stored in the MS Windows 95/NT System 
Registry.

Note Some earlier versions of TxEdit for Windows 95/NT included a TXEDIT.WRI documentation file. This file has been replaced
by the TXEDIT.HLP file and can now be deleted.

Warning If you rename the TXEDIT.EXE file you must also rename the HLP file using the same basename. For example if you 
change the TxEdit application file name to NewName.exe, rename the help file to NewName.hlp. Do not rename the 
TXEDIT.CNT file however. The HLP and CNT files must reside in the same folder as the TxEdit application file itself.



Configuring TxEdit
TxEdit Options
Select the File | Options menu item to display the TxEdit Options property sheet. This window will allow you to change the 
various TxEdit program settings listed below.

Show Tool Bar Tips
Check this item to display small popup tip windows when the mouse pointer is placed over toolbar ribbon pushbuttons. A short
description of the button currently beneath the mouse will be shown when this item is checked.

Place Icon in the Taskbar Tray
Check this item to display a small TxEdit program icon in the Taskbar Icon Notification Tray. If this item is selected and the 
TxEdit window is minimized a button will not be added to the Taskbar, to restore the TxEdit window on the desktop press the 
small icon in the taskbar tray instead. This option is available to keep the taskbar free for other running programs.

Note When this option is selected, clicking on the Close box in the upper right-hand corner of the window title bar will 
minimize TxEdit instead of closing the application. To quit TxEdit right-click with your mouse on the TxEdit icon in the Taskbar 
tray. You may also use the File | Exit menu command or the Ctrl+Q keyboard shortcut.

Confirm Program Exit
Check this item to confirm quitting TxEdit for Windows 95/NT. When this option is selected you will be prompted to confirm 
your intention to exit TxEdit and return to the MS Explorer desktop. This item is useful if you run TxEdit from the tray and wish 
to avoid accidental exits when you right-click on the TxEdit tray icon.

Dark Window Backgrounds
Check this item to display the text in list windows with a dark background instead of the paper white background MS Windows
normally uses when displaying text.

Set Word-Wrap when Opening Windows
Check this box to turn word wrapping on when opening or creating new text document windows.

New Windows 95/98 Toolbar Style
Check this item to display the toolbar ribbon using the newer “flat style” buttons.

Zoom the Editor Window at Startup
Check this item to automatically zoom the editor window when TxEdit is started. This option is provided to maintain 
consistency with the MS Windows Notepad editor’s default behavior.

Create a New Window at Startup
Check this box to automatically create a new untitled document when TxEdit is first started. This option is provided to maintain
consistency with the MS Windows Notepad editor’s default behavior.

Reopen the Last File Used at Startup
Check this box to reopen the last file used when TxEdit is launched.

Open Locked Files as Read-Only
Check this box to open write protected files as read-only. If this item is not checked and a locked file is opened you will be 
prompted to load the file as read-only.

Make Backup Copies
Check this box to automatically make a backup copy of documents that have been edited. Backup files will have the same file 
name and a file extension of BAK. This item is included to maintain consistency with the MS Windows Notepad editor’s 
default behavior.

Save Changes when Closing
Check this box to automatically save editing changes when a document is closed or TxEdit is exited. If this box is not checked
you will be prompted before closing documents that have changed.

Warning Sounds with Dialog Boxes
Check this box to play a short beep sound when TxEdit displays a warning dialog box or an error occurs.

OK
Press this button when you have completed your selection of TxEdit program options. When you press this button the TxEdit 
Options property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the TxEdit Options property sheet without making any changes. If you have made any changes to 
the option settings, and then press this button your changes will not be used, and your previous settings will remain in use.



Default
Press this button to use default TxEdit program options in this property sheet. These will be the same settings that were 
created when TxEdit was run for the first time.

Help
Press this button to open the TxEdit Help window and go directly to the Configuring TxEdit topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the TxEdit Options 
window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



TxEdit Explorer Setup
TxEdit Explorer Setup
Select the Help | Setup menu item to display the TxEdit Setup property sheet. This window will allow you to integrate TxEdit for 
Windows 95/NT with the Microsoft Windows 95/NT Explorer. Use this command to create and remove MS Explorer shortcuts.

Create a Start Menu Item
Check this item to create a TxEdit Start Menu entry. The TxEdit for Windows 95/NT program will be located in the Software by
Design folder on the Programs menu. This item will be disabled (grayed) if a TxEdit item already exists in the Software by 
Design folder.

Remove this Start Menu Item
Check this item to remove the TxEdit entry located in the Software by Design folder on the Programs menu. This item will be 
disabled (grayed) if a TxEdit item does not already exist in the Software by Design folder.

Create a Desktop Icon
Check this item to create a TxEdit for Windows 95/NT program icon on the Explorer desktop. This item will be disabled 
(grayed) if a TxEdit desktop icon already exists.

Remove Icon from the Desktop
Check this item to remove the TxEdit for Windows 95/NT program icon from the Explorer desktop. This item will be disabled 
(grayed) if a TxEdit desktop icon does not already exist.

Create a Startup Folder Item
Check this item to automatically run TxEdit for Windows 95/NT whenever Microsoft Windows is started. This option creates a 
TxEdit program icon in the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a TxEdit startup item 
already exists in the Startup folder.

Remove the Startup Folder Item
Check this item to remove TxEdit from the MS Windows Explorer Startup folder. This item will be disabled (grayed) if a TxEdit 
startup item does not already exist in the Startup folder.

OK
Press this button when you have completed your selection of MS Explorer shortcuts. When you press this button the TxEdit 
Setup property sheet will be closed and the MS Explorer shortcuts you have selected will be created or removed.

Cancel
Press this button to close the TxEdit Explorer Setup property sheet without creating or removing any MS Explorer shortcuts.

Help
Press this button to open the TxEdit Help window and go directly to the TxEdit Explorer Setup topic.



TxEdit as a NotePad Replacement
TxEdit as a NotePad Replacement
TxEdit for Windows 95/NT can be used as a replacement for the standard MS Windows NotePad editor. Select the File | 
Options menu item to display the TxEdit Options property sheet, and then pick the Files tab to specify file types that you would 
like to be associated with TxEdit instead of NotePad. The file types you specify will be opened by TxEdit when you double-click 
your mouse on any of these file icons.

You can also use this window to define custom file types that you would like to associate with TxEdit. Any file type you define will
be opened by TxEdit when you select them using the MS Windows Explorer.

Edit ASCII Text Documents with TxEdit
Check this item to associate ASCII text documents with TxEdit instead of MS NotePad. If this item is checked double-clicking 
your mouse on text files will automatically open them for editing using TxEdit instead of MS NotePad. Text documents have a 
file extension of TXT. Uncheck this box to re-assign MS NotePad as your default text file editor.

Edit Batch Scripts with TxEdit
Check this item to associate MS DOS Batch Command Scripts with TxEdit instead of MS NotePad. If this item is checked 
right-clicking your mouse on batch files and then selecting Edit from the MS Explorer Popup menu will automatically open 
them for editing using TxEdit instead of MS NotePad. MS DOS Batch Scripts have a file extension of BAT. Uncheck this box to
re-assign MS NotePad as your default batch file editor.

Edit Configuration Files with TxEdit
Check this item to associate program configuration files with TxEdit instead of MS NotePad. If this item is checked double-
clicking your mouse on configuration files will automatically open them for editing using TxEdit instead of MS NotePad. 
Configuration files have a file extension of REG, INI and INF. Uncheck this box to re-assign MS NotePad as your default 
configuration file editor.

Custom File Types to be Opened by TxEdit
You may also specify custom file types and icons that you would like to associate with TxEdit. The file associations you specify 
will automatically be opened for editing in TxEdit when you double-click your mouse on these file icons in the MS Windows 
Explorer.

Type
Use this entry field to specify a file extension type to be associated with TxEdit. The file type you specify will be opened for 
editing by TxEdit when you double-click your mouse on a file icon in the MS Windows Explorer.

File Description
Use this entry field to specify a short file description for this file type. The file description you enter here will appear in MS 
Explorer file property sheets and in various file listings.

File Icons
Use the [<] and [>] arrow buttons to select an icon to be associated with the custom file type and description you are creating.
The icon you select for this file type will appear in the MS Windows Explorer.

OK
Press this button when you have completed your selection of file associations. When you press this button the TxEdit file 
associations you have selected will be created or removed.

Cancel
Press this button to close the TxEdit Options property sheet without creating or removing any TxEdit file associations.

Help
Press this button to open the TxEdit Help window and go directly to the TxEdit NotePad Replacement topic.



Configuring the Tools Menu
Configuring the Tools Menu
TxEdit allows up to nine (9) applications to be added to the Tool menu. To define a tool select the Tools | Define Tools menu 
item. A property sheet will be displayed allowing you to specify the various tool parameters for the tool menu item you are 
defining.

Tools
Use this list dropbox to select the tool menu item you would like to define or modify. Tool menu items that are not defined will 
have a title of Undefined. The Tool menu item properties for the tool you have selected will be reflected in the window below.

Name
Enter a short name to be used as the tool menu item name. This name will appear on the Tools menu.

Active
Check this box to enable the tool menu item. If this item is not checked the tool name will appear on the Tools menu but the 
item will be disabled (grayed).

Minimize TxEdit on Tool Launch
Check this box to minimize to TxEdit’s main program window to an icon on the MS Explorer Taskbar or Icon Notification Tray. 
This option is useful to reduce screen clutter when TxEdit is used with other applications.

Program
Enter the name of the program you would like to associate with the tool menu item. Use the entire path when specifying a tool
menu item, or press the browse button [...] to the right of the entry field to select an application using the standard MS 
Windows file browser.

Command
Enter any option command arguments this tool definition may need. This is an optional item and may be left blank if you 
simply need to launch a program without any additional command arguments.

Use Active Window as Command Tail
Check this box to add the current TxEdit editing window as the program’s command tail. This selection allows you to use the 
current editing window’s filename as an additional argument to the program being launched. If a command line argument is 
specified and this box is also checked the program will be invoked with both the command line arguments you specified and 
the window’s filespec as the command tail.

Save Changes Before Launching
Check this box to automatically save any editing changes made to the current window before launching the tool menu item 
you are specifying.

Working Directory
If this entry is filled with a directory name, the folder you specify will be selected and made the default working directory before
launching the menu item tool. Press the browse button [...] to the right of this entry field to automatically select a folder using 
the folder browser dialog box.

OK
Press this button when you have completed your selection of Tool settings. When you press this button the Tool 
Customization property sheet will be closed and your tool settings will be saved.

Cancel
Press this button to close the Tool Customization property sheet without making any changes. If you have made any changes 
to the tool    settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Delete
Press this button to delete the currently displayed Tool Settings. You will be asked to confirm this command before the current 
tool is deleted.

Help
Press this button to open the TxEdit Help window and go directly to the Configuring the Tool Menu topic.

Tip Use the Ctrl+1 through Ctrl+9 shortcut keys to quickly invoke the tool menu items you have defined.

Note The Tool Menu settings you have selected will be saved when you press the OK button. The desktop location of the Tool 
Customization window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



Setting File Filters
Setting File Filters
TxEdit can be configured to open selected file types using the File | Options menu item and then picking the Filters tab.

Both the file description and extension types can be customized. To specify custom file filters select the item to be edited and 
change the text field for that item. After making the desired change press the [Accept] button at the bottom of the list box to 
save the changes.

The file filters you have defined will be available in the File Open dialog box.

Descriptions
This list displays the currently defined file filter descriptions. To edit these select an item from the list. The item you select will 
appear in the editing window directly above the Description list. Make the changes you desire and then press the [Accept] 
button at the bottom of the list of descriptions.

Note Press the [Accept] button below this list immediately after editing a File Filter Description or your changes will not take 
effect.

File Extensions
This list displays the currently defined file filter extensions. To edit these select an item from the list. The item you select will 
appear in the editing window directly above the File Extension list. Make the changes you desire and then press the [Accept] 
button at the bottom of the list of extensions.

Note File extensions must be separated by a semi-colon if you define more than a single file type.

Note Press the [Accept] button below this list immediately after editing a File Filter Extension or your changes will not take 
effect.

Select this Folder when Starting TxEdit
Check this box to set the current working directory to the folder specified above. When this settings is active TxEdit will select 
the specified directory at launch.

OK
Press this button when you have completed your selection of File Filter settings. When you press this button the File Filters 
property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the File Filters property sheet without making any changes. If you have made any changes to the 
File Filter settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Default
Press this button to use default TxEdit File Filters settings in this property sheet. These will be the same settings that were 
created when TxEdit was run for the first time.

Help
Press this button to open the TxEdit Help window and go directly to the Setting File Filters topic.

Note The File Filters you have selected will be saved when you press the OK button. The desktop location of the File Filters 
window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



TxEdit Page Setup
TxEdit Page Setup
TxEdit can be configured to use custom headers and footers when printing text documents using the File | Page Setup menu 
item.

TxEdit File Information Macros
Displayed below is a list of TxEdit File Information Macros available for inclusion in custom headers and footers.

$F = File Name The current document name with full drive and path will be inserted at the point where the $F 
macro appears.

$f = File Name The current document name without a drive or path will be inserted at the point where the $f 
macro appears.

$P = Page Number The current page number will be inserted at the point where the $P macro appears.

$T = Current Time The current time will be inserted at the point the $T macro appears.

$D = Current Date The current date in long format will be inserted at the point the $D macro appears.

$d = Current Date The current date in short format will be inserted at the point the $d macro appears.

Any other text specified in a header or footer will be treated as literal and will appear just as defined. To include the actual ‘$’ 
character in a header or footer use ‘$$’.

Header
Define the header text you wish to have appear at the top of each page printed. See the File Information Macros section 
above for a complete description of those items that can automatically be included in a header.

Print Header
Check this item to enable the header defined above. If this item is not checked the header you defined above will not be 
printed. This item is included to facilitate turning header printing on and off with out deleting the header you have defined

Center Header
Check this item to center the header at the top of each printed page. If this item is not checked the header you have defined 
above will be printed starting at the left margin.

Footer
Define the footer text you wish to have appear at the bottom of each page printed. See the File Information Macros section 
above for a complete description of those items that can automatically be included in a footer.

Print Footer
Check this item to enable the footer defined above. If this item is not checked the footer you defined above will not be printed. 
This item is included to facilitate turning footer printing on and off with out deleting the footer you have defined

Center Footer
Check this item to center the footer at the bottom of each printed page. If this item is not checked the footer you have defined 
above will be printed starting at the left margin.

Printer Page Margins
Use the following four entry fields to specify the page margins to be used when printing documents. Margin widths are 
expressed in decimal inches, for example 1.25, 0.50, .25 or 1 are all valid margin widths.

Left
Enter the left margin width in this field. Document text will be printed starting from this position on the left side on the page.

Right
Enter the right margin width in this field. Document text will be printed across the page to this position.

Top
Enter the top margin width in this field. Document text will be printed starting from this position at the top of the page.

Bottom
Enter the bottom margin width in this field. Document text will be printed down to this position at the bottom of the page.

Note If you have defined a header or footer to be printed on each page make certain that you set the top and bottom margin 
widths to at least 0.10 inches or your document text will be printed directly on top of the headers and footers you defined.



OK
Press this button when you have completed your selection of Page Setup settings. When you press this button the Page 
Setup property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the Page Setup property sheet without making any changes. If you have made any changes to the 
Page Setup settings, and then press this button your changes will not be used, and your previous settings will remain in use.

Help
Press this button to open the TxEdit Help window and go directly to the TxEdit Page Setup topic.

Note The Page Setup settings you have selected will be saved when you press the OK button. The desktop location of the Page
Setup window itself will also be stored. Your Page Setup settings will be saved in the MS Windows 95/NT System Registry.



Defining TxEdit Macros
Defining TxEdit Macros
TxEdit allows up to nine (9) custom text macros to be added to the Macros menu. To define a macro select the Macros | Define 
Macros menu item and pick the text macro item you would like to create or modify. A property sheet will be displayed allowing 
you to specify the macro name and text to be used for the macro menu item you are defining.

TxEdit text macros provide a simple means of inserting standard text and phrases in the documents you create and edit. Each 
TxEdit macro you define can contain up to 2000 characters of text.

Macro
Use this list dropbox to select the text macro item you would like to define or modify. Text macro items that are not defined will 
have a title of Undefined. The Text macro item properties for the macro you have selected will be reflected in the window 
below.

Name
Enter a short name to be used as the macro menu item name. This name will appear on the Macros menu.

Active
Check this box to enable the text macro item. If this item is not checked the text macro name will appear on the Macros menu 
but the item will be disabled (grayed).

Text
Enter the text you want to have inserted automatically in the current document when this macro is invoked from the Macros 
menu.

OK
Press this button when you have completed your selection of TxEdit macro settings. When you press this button the TxEdit 
Macro definition property sheet will be closed and your text macro settings will be saved.

Cancel
Press this button to close the TxEdit Macro definition property sheet without making any changes. If you have made any 
changes to the text macro settings, and then press this button your changes will not be used, and your previous settings will 
remain in use.

Delete
Press this button to delete the currently displayed TxEdit Macro Settings. You will be asked to confirm this command before 
the current text macro is deleted.

Help
Press this button to open the TxEdit Help window and go directly to the Defining TxEdit Macros topic.

Tip Use the Alt+1 through Alt+9 shortcut keys to quickly invoke the macro menu items you have defined.

Note The Macro Menu settings you have selected will be saved when you press the OK button. The desktop location of the 
TxEdit Macro Definition window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



TxEdit Time Stamp Settings
TxEdit Time Stamp Settings
Select the File | Options menu item to open the TxEdit Options property sheet and then click on the Time Stamp tab to display 
Time Stamp Settings. This window will allow you to specify the time stamp format used when inserting timestamps in TxEdit text 
documents. A description of the various settings follows.

Regional
Press this button to open and view the MS Windows 95/NT Regional Settings Control Panel. These setting determine the 
Time and Date formats that MS Windows uses. It is from here that you can specify the time format for 12 or 24 hour time 
strings as well as the format for long and short date strings. The settings specified here will be used when TxEdit inserts a 
timestamp in a text document.

As you make changes to the Time Stamp settings the currently selected format will be displayed in the TxEdit Time Stamp 
Settings property sheet. The format displayed will be what is inserted when you add timestamps to TxEdit documents.

Use System Date
Check this box to include the current system date in timestamps inserted in TxEdit documents. If this box is checked the long 
and short date format radio buttons directly beneath this item will be active.

Long Dates
Check this radio button to display dates in a long format such as; Mon, Jan 1 1997 or Monday, January 1 1997.

Short Dates
Check this radio button to display dates in a short format such as 01/01/97.

Use System Time
Check this box to include the current system time in timestamps inserted in TxEdit documents. If this box is checked the time 
and date format radio buttons directly beneath this item will be active.

Date - Time
Check this radio button to display the current system date before the time.

Time - Date
Check this radio button to display the current system time before the date.

OK
Press this button when you have completed your selection of Time Stamp settings. When you press this button the TxEdit 
Time Stamp Settings property sheet will be closed and your settings will be saved.

Cancel
Press this button to close the TxEdit Time Stamp Settings property sheet without making any changes. If you have made any 
changes to the settings, and then press this button your changes will not be used, and your previous settings will remain in 
use.

Help
Press this button to open the TxEdit Help window and go directly to the TxEdit Time Stamp Settings topic.

Note The options you have selected will be saved when you press the OK button. The desktop location of the TxEdit Time 
Stamp Settings window itself will also be stored. Your settings will be saved in the MS Windows 95/NT System Registry.



Recent Files Configuration
Recent File Configuration
Select the Recent | Settings menu item to open the Recent Files Configuration dialog box. Use this window to select the 
various Recent Files settings described below.

The first section of this dialog box allows you to specify file names to be ignored when adding file names to the Recent Files 
menu.

Ending with the ‘BAK’ File Extension
Check this item to ignore files ending with the .BAK file extension.

Starting with the Prefix ‘Backup of’
Check this item to ignore files starting with the prefix Backup of.

The second section of this dialog box allows you to remove all file names from the Recent Files menu.

Clear the Recent Files Menu
Check this item to clear the Recent Files menu. Checking this item will delete the 9 most recently loaded TxEdit documents.

OK
Press this button when you have completed your selection of Recent File settings. When you press this button the Recent 
Files Configuration dialog box will be closed and your settings will be saved.

Cancel
Press this button to close the Recent Files Configuration dialog box without making any changes. If you have made any 
changes to the Recent File settings, and then press this button your changes will not be used, and your previous settings will 
remain in use.

Help
Press this button to open the TxEdit Help window and go directly to the Recent Files Configuration topic.



File Menu
File Menu Commands
The File menu provides commands to work with the document files used by TxEdit. A short description of each item follows:

New
Creates a new TxEdit document. The Ctrl+N shortcut can be used for this command.

Open
Opens an existing TxEdit document, and loads it for editing or viewing. When this item is selected the standard MS 
Windows Explorer file browser will be displayed, use this window to select the document you wish to work with. Check the 
Open as Read-Only box to load documents for viewing only. The Ctrl+O shortcut can be used for this command.

Properties
Displays a small window showing file properties for the currently selected TxEdit document. This window will display the 
document’s file name, folder location, size, last modification date and file access permissions. The Alt+Enter shortcut can 
be used for this command.

Close
Closes the currently active document. If the document has been edited you will be prompted to save or discard the changes
before closing. The Ctrl+W shortcut can be used for this command.

Save
Saves changes made to the currently selected document. This menu will be disabled (grayed) if no changes have been 
made to the document since it was last loaded or saved. The Ctrl+S shortcut can be used for this command.

Save As
Saves the currently active document with a new name. When this item is selected the standard MS Windows Explorer file 
browser will be displayed, use this window to specify a new name for the document. If a file extension is not specified the 
default .TXT extension will be automatically appended. To intentionally save a file without a file extension add a single ‘.’ 
character at the end of the file name.

Discard
Use this item to discard editing changes made to a document, and reload the previous version from disk. This item will be 
disabled (grayed) if the document currently being edited has not changed since it was last saved or loaded.

Page Setup
Opens the Page Setup property sheet and allows you to change TxEdit page layout settings.

Printer Setup
Opens the standard MS Windows Printer Setup dialog box. Use this command to select a printer and page orientation.

Print
Prints the currently selected TxEdit document on your system’s printer. A dialog box will appear before printing is started to 
allow you to select the printer to be used and various other printer options. The Ctrl+P shortcut can be used for this 
command.

Options
Opens the TxEdit Options property sheet and allows you to change TxEdit program settings. Use this command to 
configure the TxEdit program.

Recent Files
This command displays a sub-menu containing up to 9 recently edited files. Select a file name from this list to quickly 
reopen a recently edited file.

Exit
Closes the TxEdit program and returns control to the Explorer desktop. The Ctrl+Q shortcut can be used for this command.

Tip Commonly used File commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Edit Menu
Edit Menu Commands
The Edit menu provides commands used to edit the contents of TxEdit documents. A short description of each item follows:

Undo
Undoes the last editing operation. The Ctrl+Z and Alt+Backspace shortcuts can be used for this command.

Cut
Cuts the current selection from the document and places it on the Clipboard. The Ctrl+X and Shift+Del shortcuts can be 
used for this command.

Copy
Copies the current selection to the Clipboard. The Ctrl+C and Ctrl+Ins shortcuts can be used for this command.

Paste
Pastes the contents of the Clipboard at the current selection point. The Ctrl+V and Shift+Ins shortcuts can be used for this 
command.

Delete
Deletes the current selection, but does not place a copy on the Clipboard. The Del shortcut can be used for this command.

Select All
Selects the entire contents of the current document. The Ctrl+A shortcut can be used for this command.

Save Selection As
Saves the currently selected section of text as a separate disk file. You will be prompted to enter a file name for the text you
wish to save using the standard MS Windows Explorer File Browser.

Insert File
Opens and inserts an ASCII text file at the current cursor location. You will be prompted to enter the name of the file you 
wish to insert using the standard MS Windows Explorer File Browser.

Insert Date
Use this command to insert the current date and time in the active document. The Ctrl+D shortcut can be used for this 
command. Use the Time Stamp Settings to specify the format of timestamps.

Find
Opens the Find dialog box and allows you to search for specified text in the currently active document. The Ctrl+F or F2 
shortcut can be used for this command.

Find Again
Repeats the current search. The F3 shortcut can be used for this command.

Replace
Opens the Replace dialog box and allows you to search for specified text and optionally replace it in the currently active 
document. The Ctrl+R shortcut can be used for this command.

Sort Selection
Sorts the currently selected range of lines in the active document. The Alt+S shortcut can be used for this command.

Lowercase
Converts the currently selected text to all lowercase characters. The Alt+L shortcut can be used for this command.

Uppercase
Converts the currently selected text to all uppercase characters. The Alt+U shortcut can be used for this command.

Read Only
Turns editing permission on and off. If this item is checked the document can be viewed but editing is not allowed.

Show Clipboard
Opens the MS Windows Clipboard and displays its current contents.

Tip Commonly used Edit commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



View Menu
View Menu Commands
The View menu provides commands used to change TxEdit display options. These items provide a means of changing the 
TxEdit window appearance. A short description of each item follows:

Toolbar
Use this command to turn the toolbar ribbon on and off. If this item is checked the TxEdit toolbar ribbon will be displayed 
below the menu bar. To hide the toolbar ribbon uncheck this item. Most commonly used TxEdit menu commands have a 
toolbar button. If the toolbar ribbon is turned off you will have to use the normal TxEdit menu commands.

Status Bar
Use this command to turn the status region on and off. If this item is checked the TxEdit status region will be displayed at 
the bottom of the TxEdit window. To hide the status region uncheck this item. The status region displays current program 
status and will also display a brief description of each menu command as the mouse is moved through these items.

Customize Toolbar
Use this command to customize the TxEdit for Windows 95/NT toolbar ribbon. The standard MS Windows Toolbar 
Customization dialog box will be opened and displayed when this command is selected.

Word-Wrap
Use this command to turn word wrapping on and off if the currently active window. When word wrapping is activated for the 
current document a small check mark will appear next to this menu item.

Go to Line
Opens the Go To Line dialog box and allows you to specify the line you wish to place the cursor on. The Ctrl+G shortcut 
can be used for this command.

OEM to ANSI
Converts the text in the currently active window from the OEM character set to ANSI characters.

ANSI to OEM
Converts the text in the currently active window from the ANSI character set to OEM characters.

Font
This item displays a popup menu containing Display and Printer font selections. When either of these items is selected the
standard MS Windows Font selection dialog box will be displayed. Use this window to select the font face, size and style to 
be used for display windows and printing. The font information you select will be saved and used whenever TxEdit is 
launched.

Minimize
Minimizes the TxEdit window to a button or icon on the taskbar. The Ctrl+Y shortcut can be used for this command.

Always on Top
Use this command to keep the TxEdit window top most on the desktop. When this item is checked the TxEdit window will 
float above all other non-topmost windows on the desktop. This item is useful if you normally run TxEdit with a small 
window that would be easily obscured by other applications. The Ctrl+T shortcut can be used for this command.

Refresh
Reloads a document from disk. The F5 shortcut can be used for this command. This item will be disabled (grayed) if the 
document has been modified. To reload a document that has been modified use the Discard command found on the File 
Menu.

Tip Commonly used View commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Tools Menu
Tools Menu Commands
The Tools menu provides commands used to launch TxEdit custom tools. The custom tools you have defined can easily be 
launched using this menu.

The upper region of this menu contains room for up to 9 custom tool items. To define a custom tool use the Tools | Define Tools
menu command and select the tool you wish to configure.

Tip Commonly used Tool commands can be invoked using the shortcut keys; Ctrl+1 – Ctrl+9.



Macros Menu
Macros Menu Commands
The Macros menu provides the commands used to insert user-defined text in the document currently being edited. The custom 
text macros you have defined can easily be inserted in the documents you create and edit using this menu.

The upper region of this menu contains room for up to 9 custom text macro items. To define a custom text macro use the 
Macros | Define Macros menu command and select the text macro item you wish to define. Each TxEdit macro you create can 
contain up to 2000 characters of text.

Tip Commonly used Macro commands can be invoked using the shortcut keys; Alt+1 – Alt+9.



Recent Files Menu
Recent    Files Menu Commands
The Recent Files menu contains a list of the last 9 TxEdit documents loaded.

Select a file name from this menu to quickly re-open a TxEdit document you worked with recently.

Select the Recent | Settings menu item to configure the Recent Files menu.



Windows Menu
Windows Menu Commands
The Windows menu provides commands used to manipulate TxEdit document windows. A short description of each item follows:

Tile Vertically
Arranges all open document windows vertically within the TxEdit window. The F7 shortcut can be used for this command.

Tile Horizontally
Arranges all open document windows horizontally within the TxEdit window. The F4 shortcut can be used for this command.

Cascade
Arranges all open document windows in an overlapping fashion within the TxEdit window. The F6 shortcut can be used for 
this command.

Arrange Icons
Arranges all minimized document windows along the bottom edge of the TxEdit window. The F8 shortcut can be used for 
this command.

Duplicate
Makes a copy of the currently active document in a new window.

Close All
Closes all document windows currently opened for editing. If document windows contain modified text you will be prompted 
to save the changes first before the windows are closed.

Open a List
Opens a list of documents specified in an indirect file list. The standard MS Windows Explorer File browser will be 
displayed, allowing you to select the indirect file list to be opened. The Ctrl+L shortcut can be used for this command.

Build a List
Builds an indirect file list of all currently open document windows. This list can be saved to disk and used later to open a 
group of files associated with a specific project. The Ctrl+B shortcut can be used for this command.

Error Codes
Opens a small window and displays a complete list of MS Windows 95/NT error codes and descriptions. The Ctrl+E 
shortcut can be used for this command.

ASCII Chart
Opens and displays the ASCII Chart window. Use this window to display ASCII character codes and to copy characters not 
easily available from the IBM PC keyboard.

SysEdit Files
Opens the SysEdit property sheet and allows the specification of up to nine configuration files to be opened automatically 
when the TxEdit /L switch is used.

Tip Commonly used Window commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Help Menu
Help Menu Commands
The Help menu provides commands used to get help with TxEdit operations. A short description of each item follows:

Contents
Opens the TxEdit Help window and displays the Table of Contents. The F1 shortcut can be used for this command.

Search
Opens TxEdit Help and displays the Search window. You can use this window to search for specific TxEdit help topics.

How to Use Help
Opens a Help window that explains how to use the MS Windows 95/NT Help program.

Register
Displays the TxEdit Shareware Registration Wizard. This wizard allows you to register    TxEdit for Windows 95/NT for 
authorized use.

Setup
Displays the TxEdit Explorer Setup property sheet. This window provides options to integrate TxEdit with the MS Windows 
Explorer. Use this window to create MS Explorer Start Menu items and desktop icons.

Web Site
Opens your web browser application and goes directly to the Software Design web site on the Internet.

Send E-Mail to Author
Opens your Internet eMail client application and allows you to send an eMail message directly to the author at 
Gregory_Braun@CompuServe.com.

Note You must have your Internet eMail client software configured as your default Simple MAPI client for this command to 
work properly.

About TxEdit
Displays the TxEdit splash box. This window contains program information, the current version of TxEdit you are running 
and a program copyright notice. Click the mouse anywhere in this window to close it

Tip Commonly used Help commands can be invoked using shortcut keys or buttons on the toolbar ribbon.



Customizing the Toolbar
Customizing the Toolbar Ribbon
The TxEdit toolbar ribbon can be customized by selecting the View | Customize Toolbar menu item. The standard MS 
Windows 95/NT Toolbar Customization dialog box will be opened when this command is invoked. Use this window to add and 
remove TxEdit toolbar buttons as well as to change the order that the buttons appear on the toolbar ribbon.

Tip you can also move and delete toolbar buttons without opening the Toolbar Customization dialog box by simply shift-clicking 
with your mouse and dragging the button to a new location on the TxEdit toolbar ribbon itself. To delete a button, shift-click and 
drag the button off of the TxEdit toolbar ribbon.

Note Some versions of MS Windows 95 redraw the toolbar ribbon height incorrectly after customization, if this happens exit 
TxEdit and then restart it again to restore the proper toolbar ribbon height.

Available Buttons
This list will contain the buttons available for adding to the TxEdit toolbar ribbon. Only buttons not currently installed on the 
toolbar ribbon will be displayed in this list.

Toolbar Buttons
This list will contain the buttons currently installed on the TxEdit toolbar ribbon.

Add
Press the Add button after selecting a toolbar button from the Available list. The tool button you have selected will be added to
the TxEdit toolbar ribbon at the current selection point.

Remove
Press the Remove button after selecting a toolbar button from the Toolbar list. The tool button you have selected will be 
removed from the TxEdit toolbar ribbon.

Close
Press the Close button to finish toolbar customization. The selection of toolbar buttons that you chose to include will be saved
and reloaded whenever TxEdit for Windows 95/NT is started.

Reset
Press the Reset button to restore the TxEdit toolbar ribbon to its original default settings.

Help
Press the Help button to open the TxEdit Help file and go directly to the Customizing the Toolbar topic.

Move Up
Use this button to move the currently selected button up one place in the toolbar button list. The currently selected button will 
appear one place to the left on the actual TxEdit toolbar ribbon when this command is used.

Move Down
Use this button to move the currently selected button down one place in the toolbar button list. The currently selected button 
will appear one place to the right on the actual TxEdit toolbar ribbon when this command is used.



Toolbar Buttons
Tool Ribbon Buttons
Most commonly used TxEdit menu commands can also be quickly invoked by pressing a button on the toolbar ribbon displayed 
at the top of the main window. These buttons work exactly the same way as the corresponding menu items that they duplicate.

The Toolbar selection on the View menu must be selected to display the toolbar ribbon.

The number of buttons and the order that the buttons appear on the TxEdit toolbar ribbon may differ from this description if you 
have customized the toolbar ribbon.

New - Create a new document

Open - Open an existing document

Save - Save changes made to a document

Close - Close the current document

Save As - Save document with a new name

Close All - Close all open documents

Save All - Save all modified documents

Print - Print the current document

Properties - Show document properties

Undo - Undo last editing change

Cut - Cut the current selection

Copy - Copy the current selection

Paste - Paste Clipboard contents

Delete - Delete the current selection

Uppercase – convert to uppercase

Lowercase – convert to lowercase

Show Clipboard - Open the Clipboard

Timestamp – Insert current date and time

Find – Find the specified text

Again – Find the specified text again

Replace – Search and replace specified text

Go To – Go to a specified line

Sort – Sort the current selection

Word Wrap – Toggle word wrapping

Duplicate – Duplicate current window



Tile Vertically – Tile windows vertically

Tile Horizontally – Tile windows horizontally

Cascade – Arrange windows

Build a List – Create an indirect list

Open a List – Open an indirect list

Topmost – Make the TxEdit window topmost

Refresh – Reload the current document from disk.

Chart – Display the ASCII/ANSI Chart

Errors – Display MS Windows 95/NT Error Codes

Font - Open the Font selection dialog

Options - Open the TxEdit Options dialog

Help - Open this Help file

About - Show TxEdit splash box

Tip If the Show ToolBar Tips option is selected a small popup tip window will appear when the mouse pointer is placed over a 
button. A short description of what each button does can be viewed using this method.



Shortcut Keys
Shortcuts
Shortcut keys allow you to quickly invoke TxEdit menu commands without first displaying the menu and then selecting an item 
from it. The most commonly used TxEdit commands can be invoked using the following shortcut keys.

File Menu
Ctrl+N Create a new Document
Ctrl+O Open an existing document
Alt+Enter Show properties for current document
Ctrl+W Close the current document
Ctrl+S Save changes made to the document
Ctrl+P Print the current document
Ctrl+Q Exit TxEdit, and return to the desktop

Edit Menu
Ctrl+Z Undo the last editing change
Alt+Backspace Undo the last editing change
Ctrl+X Cut the current selection
Shift+Del Cut the current selection
Ctrl+C Copy the current selection
Ctrl+Ins Copy the current selection
Ctrl+V Paste to the current position
Shift+Ins Paste to the current position
Del Delete the current selection
Ctrl+A Select the entire document
Ctrl+D Insert date and time in the current document
Ctrl+F Find specified text
F2 Find specified text
F3 Find specified text again
Ctrl+R Search and replace specified text
Alt+S Sort the current selection alphabetically
Alt+L Convert current selection to lowercase
Alt+U Convert current selection to uppercase

View Menu
Ctrl+Y Minimize TxEdit to a button or icon
Ctrl+T Make the TxEdit window topmost
F5 Reload a document from disk

Tools Menu
Ctrl+1 – Ctrl+9 Launch a custom tool

Macros Menu
Alt+1 – Alt+9 Insert a custom text macro

Windows Menu
F7 Tile windows vertically
F4 Tile windows horizontally
F6 To cascade windows
F8 To arrange icons
Ctrl+L Open an AutoLoad file list
Ctrl+B Build an AutoLoad file list
Ctrl+E Open the MS Windows 95/NT Error Codes window

Help Menu
F1 Display this Help file



Macintosh and UNIX Files
Using Macintosh and UNIX Text Files
TxEdit will automatically detect the type of text file being loaded when a file is first opened. It does this by looking at the end-of-
line character. UNIX files terminate lines using the newline character (ASCII 10), Macintosh files use a single carriage return 
character (ASCII 13), while Microsoft Windows and MS DOS files use a combination of both (ASCII 13 / ASCII 10).

To save a file using a different file format select the Save As item on the File menu and specify the file type in the combo box at 
the bottom of the Save File dialog.

If you simply load a file, make editing changes and then save it again the file format originally detected will be used when the file
is saved back to disk.

Note Text files must contain at least one end of line terminating sequence for TxEdit to determine the file type. Single line text 
files that do not contain an end of line character are assumed to be MS DOS text files.



Loading a Group of Files
Loading a Group of Files (indirect method)
TxEdit provides a means of loading a group of files specified through an indirect file list. An indirect file list is simply a text file 
with filenames listed one per line. Each file name listed will be opened at launch. See the INDIRECT.LST sample file for an 
example of an indirect file list.

Syntax  TxEdit @filename.lst

Note Do not put a space after the ‘@’ character, and do not create an indirect list file named ‘@filename.lst’. The ‘@’ character 
is a part of the command line, not part of the filename on disk.

Tip Indirect file lists can also be opened while TxEdit is running by selecting the Open a List option on the Windows menu.



AutoLoading Documents
Automatic Document Loading 
TxEdit can be configured to open a set of up to nine specified configuration files by invoking TxEdit with the /L command line 
switch.

Syntax    TxEdit /L

Use the Windows | SysEdit Files menu item to open the SysEdit file specification property sheet. This property sheet will allow 
you to specify the configuration files you would like to open automatically whenever the /L command line switch is invoked.



Finding Words and Phrases
Finding Words and Phrases
TxEdit for Windows 95/NT can be used to search for selected words and phrases using the Edit | Find menu command or the 
Ctrl+F and F2 keyboard shortcuts. When the Find command is issued the Find dialog box will be displayed as illustrated below:

Use this window to specify the word or phrase you would like to find using the settings described below.

Find
Use this entry field to specify the word or phrase to be found.

Whole Words Only
Check this box to search for complete words only. If this item is not checked partial words matching the search text will be 
found as well.

Match Case
Check this box to search for words and phrases that exactly match the search criteria. If this item is not checked capitalization
will be ignored when searching for words and phrases.

Keep Topmost
Check this box to keep the Find dialog box topmost on the desktop. If this item is not checked matching words and phrases 
will be highlighted and the text editing cursor will be set to the selection.

Note If this option is selected the F3 (Find Again) key will be disabled.

Find Next
Press this button to begin or continue searching for the specified words and phrases you have chosen.

Note If the Keep Topmost option is not selected the F3 key (Find Again) can be used to continue searching for the specified 
word or phrase.

Close
Press this button to close the Find dialog box and return to normal editing.

Help
Press this button to open the TxEdit for Windows 95/NT help file and go directly to the Finding Words and Phrases help topic.



Replacing Words and Phrases
Replacing Words and Phrases
TxEdit for Windows 95/NT can be used to replace selected words and phrases using the Edit | Replace menu command or the 
Ctrl+R keyboard shortcut. When the Replace command is issued the Replace dialog box will be displayed as illustrated below:

Use this window to specify the word or phrase you would like to replace using the settings described below.

Find
Use this entry field to specify the word or phrase to be found.

Replace
Use this entry field to specify the word or phrase to be used as a replacement.

Note If this field is left blank instead of replacing matching words and phrases the selected text will be deleted.

Whole Words Only
Check this box to search for complete words only. If this item is not checked partial words matching the search text will be 
found as well.

Match Case
Check this box to search for words and phrases that exactly match the search criteria. If this item is not checked capitalization
will be ignored when searching for words and phrases.

Keep Topmost
Check this box to keep the Find dialog box topmost on the desktop. If this item is not checked matching words and phrases 
will be highlighted and the text editing cursor will be set to the selection.

Note If this option is selected the F3 (Find Again) key will be disabled.

Find Next
Press this button to begin or continue searching for the specified words and phrases you have chosen.

Note If the Keep Topmost option is not selected the F3 key (Find Again) can be used to continue searching for the specified 
word or phrase.

Replace
Press this button to change the currently selected word or phrase with the replacement text.

Replace All
Press this button to search and replace all matching words and phrases.

Close
Press this button to close the Replace dialog box and return to normal editing.

Help
Press this button to open the TxEdit for Windows 95/NT help file and go directly to the Replacing Words and Phrases help 
topic.



Comments and Upgrades
Comments and Suggestions
If you have comments, questions or find any bugs in TxEdit for Windows 95/NT please feel free to contact me via email or on 
CompuServe.

Gregory Braun -– Software Design

CompuServe: 71613,2175
Email: Gregory_Braun@CompuServe.com
Web Site: http://www.execpc.com/~sbd
Phone: 1.414.444.8497

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.execpc.com/~sbd)



Release History
TxEdit for Windows 95/NT Release History

v2.0 Original in-house development and testing of MS Windows 95/NT conversion using the Microsoft Win32 SDK.

v2.1 Added 95/NT splash box for release.

v2.2 Added option to place the TxEdit program icon in the taskbar notification tray. All dialog box desktop locations are now 
saved in the INI file.

v2.3 Added a File Filters dialog box. Fixed several minor bugs, and improved the overall loading speed.

v2.4 Added an option to select Word-Wrapping when opening and creating new files. Added a right-button popup menu and 
the Save Selection As option.

v2.5 Fixed several printing bugs. 

v2.6 Increased document size from 512K to 1 meg. Increased the MRU list to 9 items. Fixed missing tabs when printing.

v2.7 Fixed popup menu Find/Replace bug. Added support for screen colors as defined in the Display Properties dialog. Added
default user and company name to the splash box.

v2.8 Fixed a bug that caused a program crash (GPF) when loading or converting UNIX and Macintosh text files. 

v2.9 Added the Save Changes when Closing option. Added facility to open and create new windows using the current MDI 
window state, i.e. normal or maximized.

v3.0 Added Tool Menu and Customization dialog. Fixed the bug that prevented exits if the autosave option was specified and 
a new file was created.

v3.1 Added MS Windows 95/NT Help file. Fixed printer bug that prevented the last character on a line from be printed 
properly when word-wrapping was active. Increased document size to 2.5 meg. Moved program settings and options to 
the MS Windows 95/NT System Registry, eliminating the need for the TXEDIT.INI configuration file. Added MS Windows 
95/NT Explorer Setup facilities. Fixed a bug that prevented user-specified file extensions from being properly applied. 
Fixed a bug in the MRU file menu, items now appear in the order of most recent use. Added OEM / ANSI character 
conversion facilities.

v3.2 Added an ASCII Chart window. Fixed a bug in the Save Selection As function that prevented the proper selection of a 
portion of a document from being saved to disk.

v3.3 Increased document size to 5 Megabytes per file. Added user-defined text insertion macros.

v3.4 Added Page Setup dialog to specify custom headers, footers and page margins. Added a command to open and insert 
files at the current cursor location. Converted the TxEdit Options dialog box to an eight-tab property sheet. Increased the 
maximum document size to 10 Megabytes.

v3.5 Fixed a bug that prevented the printing of single ‘&’ characters, and the miscalculation of printer page heights.

v3.6 Added facilities to customize the toolbar ribbon.

v3.7 Fixed a bug that prevented the proper repositioning of TxEdit windows on the desktop when the MS Explorer taskbar 
was located on the left edge or at the top of the display and Auto Hide was active. Added options to the Edit Menu to 
insert the current system date and time in a document and to sort text selections alphabetically. Added an option to the 
View Menu to refresh the currently active document from disk. Improved the speed of Find and Replace operations by 
using native Win32 RichEdit control messages. Added new toolbar buttons for Save All, Close All, Sort, Topmost, 
Refresh, Timestamp, the ASCII Chart and MS Error Code commands.

v3.8 Fixed a bug that prevented the proper font size when printing TxEdit documents. Fixed a bug that prevented the Enter 
key from properly initiating a search from the Find and Replace dialog boxes. Added quotes to custom tool filename 
arguments that contained spaces.

v3.9 Fixed a bug that prevented the original file creation and modification timestamps from being retained when backup files 
where created. TxEdit now behaves like a true Taskbar Tray application when the Place Icon in the Taskbar Tray option
is selected. Added facilities to assign TxEdit as the replacement for    the Microsoft Windows NotePad editor. Several 
other minor bugs have been fixed.

v4.0 Added the .REG file type to TxEdit NotePad replacements. The Save As command now appends the default .TXT file 
extension when only a file name is specified. Right-clicking the mouse on the TxEdit icon in the Taskbar tray will quit 



TxEdit and return to the MS Explorer Desktop. Added the Shareware Registration Wizard. The MS Windows Error Code 
list can now be printed.

v4.1 Added the Save As menu command for the MS Windows 95/NT Error codes. Fixed several minor bugs. 

v4.2 Restored the older MS Windows 3.0 editing shortcut keys. Fixed several minor bugs. 

v4.3 Added settings to start from a specified folder when launching TxEdit. Added support for MS Windows 98. Fixed several 
minor bugs. 

v4.4 Added the Find Again (F3) Edit Menu item. Fixed several minor bugs. 

v4.5 Added a Recent Files Menu. Fixed several minor bugs. 

v4.6 Added a facility to optionally keep the focus on the Find and Replace dialog boxes. Added new buttons to the toolbar 
ribbon. Added an option to display the toolbar ribbon using the newer MS Windows 95/98 flat style buttons. Fixed several
minor bugs. 

Last Update  November 11th, 1998

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.execpc.com/~sbd)



System Registry
TxEdit for Windows 95/NT System Registry Key
TxEdit for Windows 95/NT stores configuration settings in the MS Windows 95/NT System Registry. These settings are updated 
automatically while TxEdit is running. There is no need to edit these settings manually.

If you insist upon editing these settings, you do so at your own risk. TxEdit automatically updates registry entries when it exits. If 
you edit these settings make sure TxEdit is not running while you edit them. If TxEdit is currently running your changes will be 
overwritten when TxEdit exits.

TxEdit for Windows 95/NT stores configuration settings in the following system registry key:

HKEY_CURRENT_USER
Software

Software by Design
TxEdit for Windows 95/NT

Section
Label = Value

Warning There is no need to edit these settings manually. TxEdit will automatically maintain these settings for you. If you do edit
these, you do so at your own risk.



Removing TxEdit
Removing TxEdit for Windows 95/NT
If you find that TxEdit for Windows 95/NT does not meet your ASCII text editing needs you can remove it from your computer 
system by simply deleting the following files from your hard drive.

All of these files will be located in the folder that you originally installed TxEdit in.

The default location for all TxEdit for Windows 95/NT program files is the C:\Program Files\Software by Design folder. Unless 
you specified a different folder when you ran SETUP.EXE you will find the TxEdit files here.

TxEdit.exe TxEdit application program.
TxEdit.cnt TxEdit Help Topics File
TxEdit.hlp TxEdit Help File

If you have opened and used the TxEdit for Windows 95/NT Help files your system may contain the following two (2) files. These
files are created by the standard MS Windows 95/NT Help program WinHlp32.exe. These files may also be safely removed.

TxEdit.gid MS Windows Help settings file. This file contains the TxEdit Help window size and desktop location as well 
as any bookmarks you may have created.

TxEdit.fts MS Windows Help word database. This file is created when you build a custom word list for TxEdit Help 
files. This file is used to search for words and phrases in the TxEdit Help files.

TxEdit for Windows 95/NT does not use any custom DLL files or system drivers. If you delete the files mentioned above from 
your system’s hard drive you will have completely removed TxEdit from your computer system.

Note If you have installed TxEdit shortcuts on the MS Explorer Start Menu use the Help | Setup command to remove the 
shortcuts you created before you delete the TxEdit files mentioned above.



Software Design Web Site
Software Design
You can download the latest versions of all of my software from my web site on the Internet. I post the latest releases of my 
software there first. Click your mouse on the link listed below to visit the Software Design web site.

Software Design Web Site

(http://www.execpc.com/~sbd)

Software Titles
The following software titles are available at my web site on the Internet and can also be found on CompuServe, ExecPC, MSN 
and ZD Net.

NoteBook for Windows (NBOOK.ZIP)
NoteBook for Windows 95/NT (NBOOK32.ZIP)
Reminders for Windows (REMIND.ZIP)
Reminders for Windows 95/NT (REMIND32.ZIP)
ToolBar for Windows (TBAR.ZIP)
ToolBar for Windows 95/NT (TBAR32.ZIP)
Screen Loupe for Windows (LOUPE.ZIP)
Screen Loupe for Windows 95/NT (LOUPE32.ZIP)
Screen Loupe for Macintosh (LOUPE.SEA)
Audition for Windows 95/NT (AUDITION.ZIP)
Password Keeper for Windows 95/NT (PASSKEEP.ZIP)
CardBase for Windows 95/NT (CARDBASE.ZIP)
Go Postal for Windows 95/NT (GOPOSTAL.ZIP)
File Editor for Windows (FXEDIT.ZIP)
File Editor for Windows 95/NT (FXEDIT32.ZIP)
Crypto for Windows 95/NT (CRYPTO.ZIP)
Icon Extractor for Windows (ICONX.ZIP)
Icon Extractor for Windows 95/NT (ICONX32.ZIP)
TxEdit for Windows 95/NT (TXEDIT.ZIP)
DLL Show for Windows 95 (DLLSHOW.ZIP)
RGB Editor for Windows (RGB.ZIP)
RGB Editor for Windows 95/NT (RGB32.ZIP)
Quiz Wizard for Windows 95/NT (QUIZWIZ.ZIP)
FontShow for Windows 95/NT (FONTSHOW.ZIP)
Submit It for Windows 95/NT (SUBMITIT.ZIP)
File Shredder for Windows 95/NT (SHREDDER.ZIP)
Submit It for Windows 95/NT (SUBMITIT.ZIP)
Programmer's IDE (PMAN.ZIP)
Programmer's IDE 95/NT (PMAN32.ZIP)
Touch for Windows (WTOUCH.ZIP)
Disk CleanUp for Windows 95/NT (CLEANUP.ZIP)
BattleStar for Windows (BSTAR.ZIP)
BattleStar for Windows 95/NT (BSTAR32.ZIP)
World Radio for Macintosh (WRADIO.SEA)

Note The latest versions of my software programs are always posted on my web site first. Versions found on the other online 
services may be earlier releases.



BBS and Internet Operators
Webmasters
Please upload the original ZIP file intact and title the submission:

"TxEdit for Windows 95/NT v4.6"
--Author Gregory Braun

Web Site
Visit my web site on the Internet to download the latest versions of all of my software offerings.

Software Design Web Site

(http://www.execpc.com/~sbd)

Note This site also supports anonymous FTP transfers.



What is Shareware
The concept of "Shareware"...
Shareware, also known as user supported software and other names, is a concept not understood by everyone. The author of 
Shareware retains all rights to the software under the copyright laws while still allowing free distribution. This gives the user the 
chance to freely obtain and try out software to see if it fits their needs. Shareware should not be confused with Public Domain 
software even though they are often obtained from the same sources.

If you continue to use Shareware after trying it out, you are expected to register your use with the author and pay a registration 
fee. What you get in return depends on the author, but may include a printed manual, free updates, telephone support, etc. Only 
by paying for the Shareware you use do you enable the Shareware author to continue to support his software and create new 
programs. Considering that the Shareware registration fees are almost always far less than the purchase price of comparable 
commercial software it's obvious that Shareware is a good deal for everyone.

There are real advantages to you in the Shareware system. You get to try out software to make sure it is compatible with your 
hardware and that it fits your needs before you "buy" it with your registration. The author saves the expense of advertising, 
packaging and distribution and passes the savings on to you. Plus, most Shareware authors are much more accessible than 
commercial software sources so that your questions and suggestions are much more likely to be responded to.

Thank you for your support.



Registering TxEdit for Windows 95/NT
Registering TxEdit
TxEdit for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are 
required to register it. If after evaluating TxEdit for 30 days you decide not to register it you are required to remove it from your 
computer.

Registration entitles you to unlimited free updates and telephone support.

You can register TxEdit for Windows 95/NT by mailing the Order Form provided with this software. When you register TxEdit for 
Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your registration code be 
mailed to you.

You may also purchase TxEdit for Windows 95/NT using your credit card via the Internet or by telephone.

The software you are currently using is a fully functioning program. As a registered user you will however be able to disable the 
initial splash box that appears when TxEdit for Windows 95/NT is first launched.

To register your copy of TxEdit for Windows 95/NT select the Help | Register menu command. The Shareware Registration 
Wizard will be displayed when this menu command is selected. Use this window to fill in the following entry fields:

User Name
Enter the user name you originally specified when you ordered TxEdit for Windows 95/NT.

Organization
Enter the name of your organization as originally specified when you ordered TxEdit for Windows 95/NT. If you did not specify 
an organization name leave this field blank.

Registration
Enter the registration code that was provided to you. Enter your registration code exactly as provided. Do not include spaces 
when entering your registration code.

Note The registration code was provided to you when you purchased TxEdit for Windows 95/NT. Refer to the notification letter
that was mailed to you or the E-Mail message you received for your personal shareware registration code.

Show Splash Box at Startup
This box will be initially checked if you have not registered TxEdit for Windows 95/NT. When you successfully register your 
copy of TxEdit this box will automatically be unchecked for you. If you wish to see the splash box when TxEdit is launched 
return to this Registration Wizard and check this box.

OK
Press this button after you have filled out the Shareware Registration Wizard to complete TxEdit for Windows 95/NT 
shareware registration.

Cancel
Press this button to close the Shareware Registration Wizard    without making any changes.

Help
Press this button to open the TxEdit Help window and go directly to the Registering TxEdit topic.



Purchasing Information
Purchasing Information
TxEdit for Windows 95/NT is distributed as shareware. You may evaluate it free of charge for 30 days. After 30 days you are 
required to register it. If after evaluating TxEdit for 30 days you decide not to purchase it you are required to remove it from your 
computer.

Registration entitles you to unlimited free updates and telephone support.

You can register TxEdit for Windows 95/NT by mailing the Order Form provided with this software. When you register TxEdit for 
Windows 95/NT you will receive your registration code by E-Mail, or optionally you may request that your registration code be 
mailed to you.

You may also purchase TxEdit for Windows 95/NT using your credit card via the Internet or by telephone.

The software you are currently using is a fully functioning program. As a registered user you will however be able to disable the 
initial splash box that appears when TxEdit for Windows 95/NT is first launched.

Single User Licensing
Individual users can register TxEdit for Windows 95/NT for $20.00 dollars. If you would also like a 3 ½” floppy disk sent to you 
please add an additional $5.00 dollars. Registration entitles you to unlimited free updates and telephone support. You can 
always download the latest release of TxEdit directly from the Software Design web site on the Internet. Print the TxEdit for 
Windows 95/NT Order Form and mail it with your check to become a registered user of TxEdit for Windows 95/NT.

Site Licensing
TxEdit for Windows 95/NT can also be registered for use at an entire site for $250.00 dollars. If you would like to install and use 
TxEdit on multiple workstations at a single location choose this type of licensing. Registration includes a 3 ½” floppy disk and 
entitles you to unlimited free updates and telephone support. You can always download the latest release of TxEdit directly from 
the Software Design web site on the Internet. Print the TxEdit for Windows 95/NT Order Form and mail it with your check to 
become a registered user of TxEdit for Windows 95/NT.

Corporate Licensing
TxEdit for Windows 95/NT can also be registered for use at multiple sites for $1000.00 dollars. If you would like to install and use
TxEdit on multiple workstations at multiple locations choose this type of licensing. Registration includes a 3 ½” floppy disk and 
entitles you to unlimited free updates and telephone support. You can always download the latest release of TxEdit directly from 
the Software Design web site on the Internet. Print the TxEdit for Windows 95/NT Order Form and mail it with your check to 
become a registered user of TxEdit for Windows 95/NT.



TxEdit for Windows 95/NT Order Form
To print this order form, press the Print button above, or select Print Topic from the File pull-down menu.

Secure on-line credit card orders can be placed from the Software Design web site.

To order by check, send this order form and a check to:

Gregory Braun
P.O. Box 1307
Milwaukee, WI    53201-1307 U.S.A.

Payments must be in US dollars drawn on a US bank, or you can send international postal orders in US dollars.

All orders are subject to the License Agreement.

Customer information is considered confidential and will not be shared or distributed to any third parties.

Registered users of TxEdit for Windows 95/NT are entitled to unlimited free program updates.

Single User Copy ______ at $20.00 each = ________

Optional 3 ½” Disk ______ at $5.00 each = ________
Site License ______ at $250.00 each = ________

Includes 3 ½” Disk
Corporate License ______ at $1000.00 each = ________

Includes 3 ½” Disk

Wisconsin Residents add 5.5% sales tax: ________

Total Payment: ________

Date ____________________________________

Name ____________________________________

Organization ____________________________________

Shipping Address ____________________________________

____________________________________

City ____________________________________

State ____________________________________

Zip Code ____________________________________

Country ____________________________________

Day Phone ____________________________________

E-Mail Address ____________________________________
[    ] Please send registration code via E-Mail

Comments:





Credit Card Purchases
Credit Card Purchases
You may purchase TxEdit for Windows 95/NT by credit card over the telephone or directly from my web site on the Internet.

On-line Registration
Secure on-line registration using a major credit card is available directly from the Software Design web site. Simply go to the 
TxEdit for Windows 95/NT program description page and click your mouse on the RegNet link. You may register TxEdit for 
Windows 95/NT using your Master Card, Visa, American Express, Discover or EuroCard. Registration keys will be sent to you 
via eMail.

Telephone Registration
You may also purchase TxEdit for Windows 95/NT toll-free by telephone. Please specify TxEdit for Windows 95/NT when 
ordering.

Toll-Free: 1.800.999.2734
International: 1.805.288.1827
FAX Line: 1.805.288.1867

Web Site
Click your mouse on the underlined link below to purchase TxEdit for Windows 95/NT by credit card.

Software Design Web Site

(http://www.execpc.com/~sbd)



License Agreement
License Agreement

You should carefully read the following terms and conditions before using this software.    Unless you have a different license 
agreement signed by Gregory Braun, your use of this software indicates your acceptance of this license agreement and 
warranty.

Registered Version
One registered copy of TxEdit for Windows 95/NT may either be used by a single person who uses the software personally on
one or more computers, or installed on a single workstation used nonsimultaneously by multiple people, but not both.

Site License
Any number of users at a single location may access the registered version of TxEdit for Windows 95/NT through a network, 
provided that you have obtained a site license for the software covering all workstations that will access the software through 
the network. Any number of users at a single location can install and use the software on one or more computers or 
workstations.

Corporate License
Any number of users at any number of locations may access the registered version of TxEdit for Windows 95/NT through a 
network, provided that you have obtained a corporate license for the software covering all workstations that will access the 
software through the network. Any number of users at any number of locations can install and use the software on one or 
more computers or workstations.

Software Updates
Registered users of TxEdit for Windows 95/NT are entitled to unlimited free program updates. Software updates can be 
downloaded directly from the Software Design web site on the Internet.

Governing Law
This agreement shall be governed by the laws of the State of Wisconsin.

Disclaimer of Warranty
THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT WARRANTIES AS TO 
PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES WHETHER EXPRESSED OR IMPLIED. NO 
WARRANTY OF FITNESS FOR A PARTICULAR PURPOSE IS OFFERED.

Good data processing procedure dictates that any program be thoroughly tested with non-critical data before relying on it. The
user must assume the entire risk of using the program.    ANY LIABILITY OF THE SELLER WILL BE LIMITED EXCLUSIVELY 
TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.



Customizing Help
Customizing Help
You can customize this help file to better suit your needs and uses. The following topics describe the various settings that can be
configured. The settings you specify will be saved and used again each time you view this help file.

Font Size
The size of the font used in this help file can be made larger or smaller by selecting the Font item from the Options menu 
above. Select Small, Normal or Large fonts from the popup menu. The font size you select will be saved and used again each 
time you view this help file.

Window Size
The size of this Help window and its location on the desktop can be adjusted using the standard Windows resizing and 
placement methods. The window size and its location on the desktop will be saved and used again each time you view this help 
file.

Window Background Color
The background color for this help window can be changed to white if you prefer. To change the background color to white select
the Use System Colors item from the Options menu above. For the color changes to take effect you will have to close and 
then reopen the Help file. You will be prompted to confirm this action. Your background color selection will be saved and used 
again each time you view this help file.

Window Placement
By default this help window positions itself in front of all other open windows. If you would prefer to have it covered up by other 
active windows select the Keep Help on Top item from the Options menu and then select Not on Top from the popup menu. 
Your selection will be saved and used again each time you view this help file.






